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  Introduction

Introduction

System overview
Welcome to the Blink Mailer Manual.

This first chapter will explain what Blink Mailer is used for and give you a basic
overview of how it works.

What is Blink Mailer?
Blink Mailer is used for sending email newsletters, announcements and
notifications. It is designed to send a single message (a campaign), by email to
large numbers of recipients (subscribers).

You organise your subscribers into lists and you can import email
addresses from your email account, online shop, blog or database. You can
also import attribute data, for example, subscriber name, city or shoe size.

Campaigns are composed in a web interface and can be personalised for each
subscriber. Personalisation is done with the use of placeholders which display
attribute data within the text of the emails, as well as unique links that allow
subscribers to join or leave lists easily. You can use plain text, HTML and
templates.

Once a campaign has been sent, Blink Mailer will show statistics about it. This
will include opens/views (who read the campaign), clicks (who clicked which
link in the campaign) and bounces (which addresses were incorrect and
delivery failed). Bounced mails and unsubscribes are automatically removed
from the system, which will benefit future delivery of campaigns. 

Blink Mailer uses phplist which is Open Source software and it is published
under the AGPLv3 licence. 

A quick tour of Blink Mailer
Blink Mailer has an attractive web interface and a wealth of features to
explore. 
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Campaigns
Composing and sending campaigns is achieved by following a step by step
process.

 

Subscribers
In Blink Mailer you upload your contacts once and the information is ready to
use every time you send a campaign.

 

You can group subscribers into one or more lists 

pg 4



  Introduction

 

Simply choose which list you want to send to when you create your campaign.
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Subscribe pages
Subscribers can sign up to your lists though subscribe pages, which are fully
customisable.

...and can be integrated with your website.
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Campaign Statistics
You can view basic and detailed statistics about every campaign you send to
help you learn more about your subscribers.

What does Blink Mailer not do?
Blink Mailer is a one-to-many email program. It cannot easily be used to have
"email conversations" many-to-many as you might do on software such as
mailman. 

pg 7



  Introduction

Case Studies
Below are four examples of how Blink Mailer is used, including a small
business, a medium business, a large business and a community group. They
are ordered by the number of emails sent per month. 

•Large business - up to 150,000 emails per month
•Medium business - 10,000 emails per month
•Small business - 500-1000 emails a month
•Community Group - 500 emails a month

Large Business
SA Flyers is an example of business that sends out +20,000 emails per month
and has over 100,000 subscribers.

 

And these subscribers are divided into smaller lists by Province, for example.

They grow their lists by sign up's though their website and from special offers
and promotions throughout the year.

The aim of the SA Flyers newsletter is to provide readers with relevant
information and special offers for their various products.

Their Blink Mailer system is managed by two staff members: one who
assembles campaigns and another who updates the lists and sends the
campaigns, as well as dealing with any technical issues.
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SA Flyers started their newsletter in 2009 when they launched their website: a
newsletter has always been integral to their business model. Initially they used
proprietary hosted solutions which they found too expensive. They then tried
using a 'homegrown' solution but they soon outgrew its capabilities. For them
Blink Mailer was the happy medium. SA Flyers has been using Blink Mailer
since 2012.
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Medium Business
Attila Fodor (FineCutBodies) is a musician, producer and a former developer
(of playstation games!).

He runs an indie record label which has had more than 60 releases and
hundreds of gigs since 2000. He goes on world tours and has aired over 700
hours of radio content in the last 15 years. He also teaches at the Budapest
School of Music Technology, running a regular class on digital technology and
basic sound design paradigms.  

FineCutBodies started a newsletter when he founded his record label in 2001.
He began by pasting email lists into the Bcc line in his mail software. When the
list started to grow he tried a few different newsletter programs.  

In 2014 he started searching for a newsletter software which could provide
bespoke functionality and smooth website integration. As an audiovisual coder
and video game developer, FineCutBodies has used his coding experience to
customise Blink Mailer to his needs.
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One example of this customisation is his download-for-signup system, where a
visitor to the FineCutBodies.com website requests a free track/tool download in
exchange for signing up to the mailing list.

They then receive an email with the download url in: when the url is clicked
the visitor is subscribed to the list on his Blink Mailer system.

Additionally, subscribers are integrated seamlessly into the Blink Mailer system
using javascript, rather than using the standard Blink Mailer subscribe pages. 

  

FineCutBodies has a total of 10k emails across several public lists, as well as a
private list for pre-release news aimed at music journalists.

The subscribers come from various online contact and sign up forms (see
screenshot as well as the subscribe-for-download deal). FineCutBodies send
one campaign per month per list and have an average recorded open rate of
20-30%. 
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Small Business 

Ethical Pets is an online store which sells Bio/Organic, ecological and fairly
traded pet products.

They began using Blink Mailer to send out a newsletter called The Ethical Pets
Gazette five months after they launched their store, and have now been
running the list for nearly three years.  

Ethical Pets 

• Publicise the ethical qualities of new products 
• Share blog articles about environmental and animal welfare campaigns
• Encourage the feeling of friendship and community present in fairs and

festivals

The Ethical Pets Gazette now has 750 subscribers. Most are customers whose
addresses were exported from online shop software. There is an AJAX sign up
form on their shop front and they sometimes segment their lists to target
specific customer groups, for example, dog owners or cat owners.

Their average open rate is as high as 36%.
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Community Group
The Parliament of South Africa is legally required to inform the citizens of
South Africa about their work. Responsibility for this task falls on the manager
of the Content and Information Unit at Parliamentary Communication Services,
who is mandated to spread this information to as broad a range of readers as
possible.

One of the methods used is the Insession newsletter, which is published on a
monthly basis on their website as a pdf and ebook.

Blink Mailer is used to target the audience that wish to receive this newsletter
digitally. Insession is sent to subscribers as an HTML email with links to longer
articles on the government website.
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The Content and Information Unit have used Blink Mailer since March 2013,
and the software was chosen by the IT department.

Currently the Insession list has about 450 members, all of whom subscribed
themselves via a web form during the normal course of parliamentary
business.

Four staff of the Content and Information Unit manage the Blink Mailer. Two
have access to the subscribers' replies and two upload the newsletters as an
ebook and pdf onto the parliament.gov.za website.

The government of South Africa also uses Blink Mailer to run an internal
parliamentary list.
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User Manual
This contents of this manual has been written by the phpList community
documentation team, individual volunteers, companies and phpList Ltd staff.
The contents has further been summarised and edited by Warren Eades of
Blink for clients using Blink Mailer. 

Aims
This manual will teach you how to use Blink Mailer. It provides real life
examples where possible and chapters are goal oriented. We hope you will
come away from each chapter with inspiration and motivation as well as an
education!

Target audience and assumptions 
The manual is aimed at users with average tech skills who are starting at the
beginning with Blink Mailer.

Disclaimer
Software is not static, it continuously changes. Blink Mailer is no different from
other software, in that it is regularly updated to fix issues, add new features
and respond to a changing environment of browsers and internet technology.
This manual attempts to provide you with a guide to how Blink Mailer works,
but the version you are using may be different from what is described here.
The manual should help you to work Blink Mailer in a general way, but you
may need to interpret it for your situation to make Blink Mailer do what you
want it to do. 

How to use this manual
Most chapters will walk you through a task, with a screenshot for each stage.
It may be that you only require assistance with one aspect of a task, in which
case skip ahead. 

Styles
Each level of a menu is signified with a >. If you need to go to Subscribers in
the main menu, and then click Add new in the sub menu, the we would
annotate this as Subscribers > Add new. 
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Documentation team
Thanks to all the the following contributors, in no particular order:

Dragonrider, Nikita Lyalin, Paul Mellors, Dan Waterloo, Elisa, Michiel, Mariela,
Orsiris de Jong, JoJo, Lucas Schneider, Guido Hornig, Vedran Vucic, Sylvain,
Andreas Tolfsen, Titano, Charlie Russell, Joseph Morris, Björn Balazs,Mindhack,
Alexandru Berendei, Marius, Sam Tuke, Marcela Lopez Levy, kitchm, Rodrigo
and Linda Ainsworth.

Thanks to phplist
phplist is an open source product and is fully integrated into Blink Mailer. A
portion of all profits are contributed from Blink to phplist in order to support
past and future developemnets.
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Basic Usage

Logging in
Blink Mailer when you are logged out
When you are not logged in, any page you visit in your Blink Mailer installation
will prompt you to enter your username and password. For example, if I visit
my dashboard, which usually resides at my-domain.com/lists/admin: 

I would see my login prompt, marked below in red.
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How to log in to Blink Mailer
To log in, enter the username in the Name: box and password in the
Password: box, then click Continue. The default username is admin, however,
your system administrator may give you a more personalised login.

When you have successfully entered your username and password you will see
the page you were trying to access. In this case, the Dashboard. 

It is a good idea to bookmark your dashboard and use it as the primary way to
access your Blink Mailer. Depending on your configuration, your dashboard
might look a little different, for example there might be more items on your
menu bar.
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How to log out of Blink Mailer
The Logout button will always display in the top right of your installation.

Remember to logout when you are not using Blink Mailer: your installation
contains the personal data of your subscribers and it is your responsibility to
keep it secure. 

Adding your first subscribers
This chapter wil l explain how to make a list of email recipients,
called subscribers, and how to send your email campaigns.

Blink Mailer is a powerful tool: there are several ways to add subscribers and
demographic information about them (name, location, interests etc).

In this chapter we are going to cover the most basic scenario. 

How to get your first subscribers
The chances are, if you are planning to use Blink Mailer, you have some
subscribers already. You may have a complex database of contact information,
a list you exported from an application, or a simple list of emails on a sheet of
paper.

In this example, we will be following the progress of Ethical Pets, who we
introduced in the Case Studies chapter. They will be emailing customers of
their online shop. The list of emails was obtained by exporting a list of
customer emails from their shop software.

Create a list in Blink Mailer
First of all you need to create a subscriber list. This will help you organise your
subscribers. In Blink Mailer, you must have at least one list, but you can have
many of them. In this example, we will create just one list called The Ethical
Pets Gazette, which is the name of the Ethical Pets newsletter.

First, navigate to Subscribers > Subscriber lists in the main menu.
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This will take you to a page which shows you all your lists. Currently you can
see just one list, a system default list called test.

To create a new list click the Add a list button. 

You then need to enter your List name and List description (which may be
displayed publicly).

In this case, you tick the Public list box too, because we want people to know
about the list. 
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Add Subscribers to Blink Mailer by copy and paste 
Once this page is complete, click Save. You can edit this page again later if you
need to. Next we click Add some subscribers 

This will bring us to the Import Subscribers by Copy and Paste page.
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We now need to copy our list of subscribers. In this case, the list has been
stored in Libreoffice Calc. Right click the column which contains the emails and
click Copy. 

 

Then, returning to Blink Mailer, we right click in the input box and
select Paste. 
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Finally, we click Import emails. 

 

And we are informed of the results of our import,
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Check it out! 
If we return to Subscribers > Subscriber lists in the main menu, we can see
the new list and its subscribers. 

Asking and assuming permission
Before you start to make lists, take some time to consider who you add. A
healthy email list is full of people who want to receive your mail: they should
have given you their email address voluntarily and ideally been asked for
permission before you add them to the system.

There are legal requirements in South Africa which reflect the importance of
informed or assumed permission.

Long term subscriber list health
The ideal situation is for your list members to join and leave your list as they
please. You can set up Subscribe pages so people can subscribe themselves to
your lists, and the (mandatory) Unsubscribe link in your emails will allow
people to leave if they want to. These are discussed in detail in other
chapters. 

While you may be keen to spread your message as far and wide as possible,
always bear in mind that excessive, aggressive and intrusive emails can
tarnish your brand. Don't become a spammer! 

pg 24



  Basic Usage

Sending your first campaign
Once you have composed your html message, you are ready to move though
the tabs (highlighted in red below) which will guide you through the process of
sending your first mail.

Format
If you have a template set up already then the Format gives you the
opportunity to choose it by selecting it from the Use template drop down. Your
html message will then be wrapped in the template during the sending phase.

You can send a test message using the Send test box at the bottom of the
page, to see what your email will look like.

Click next when you have selected your template. If you do not yet have a
template, leave the -- select one in the dropdown and click next.
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Schedule your campaign 
After your tests you need to schedule your campaign on tab 3: Scheduling.
Remember, some plugins and settings add extra tabs so the tab number may
change (but the name should stay the same). 

In this case we want to send the mail straight away, so the Embargoed
until time needs to be left as the default, which is slightly in the past.

Additionally, because this campaign is not time sensitive, for example there is
no deadline for the special offer, we can leave the Stop sending after time and
date as the default too (far in the future).

 When you have finished entering the scheduling information, click next.

  

Select your lists
One of the final stages in the campaign workflow is to choose the list(s). In
this case there is only one list to choose from, which is The Ethical Pets
Gazette. The options for All Lists and All Active Lists are also useful; the former
sends to every list, public or private, and the latter sends to all public lists.

Remember that Blink Mailer will only send each subscriber one copy of each
campaign, even if they are on several lists: you don't need to worry about
sending people duplicate copies. 
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Once you have chosen your lists click Next

Sending your campaign
Sending in Blink Mailer is a powerful tool with many possible configurations. It
is possible that your system administrator will give you different instructions
for sending or will send on your behalf.  

The final tab in the sequence contains a few useful details and the button
which triggers sending.

First of all you can chose some emails that you wish to alert when your
campaign starts sending and finishes sending. This can help you stay
organised.

You can also choose to Reset click statistics - this means that any clicks or
opens recorded when you were testing your campaign will be forgotten, so
when you get new clicks and opens you know they are from your subscribers.
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When you are ready to send, click send campaign.

Process your queue  
Clicking send will add your campaign to your queue. There may be only one
campaign in the queue, or there may be several. Click process queue to send
the campaign now. 

You will see the queue start to process, with a spinning logo. 

Next you will see something like the image below, depending on how your
system is configured.
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All done?
Blink Mailer is configured to run in the background so there is no need for you
to leave the page open or your computer on. Alerts will be sent out every time
450 emails are sent (every 2 hours) and when the campaignhas been
completed.

Basic campaign statistics
Now that you have sent your first campaign, it's time to take a look at your
campaign statistics. In this chapter we will look at Sent, Rate Bounces,
Forwards and Views, the four most fundamental campaign statistics.

The statistics overview page 
First, go to Statistics > Statistics overview.

This will show you a summary of all the campaigns you sent in the past year
(in this case, we have just sent one).

Sent
In this example, we sent our first campaign to 621 subscribers and this is
reflected in the SENT column. It is useful to see how many subscribers you
have for each campaign, so you can see your list grow over the year. 
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Bounces
The second column BNCS shows the number of emails that "bounced." A
bounced email is one that cannot reach its intended recipient. This could be
caused by any number of things, for example: 

• The email is incorrect, does not exist or has an error such an expired
domain

• The Mailbox is full (this may be temporarily or not)
• A badly configured auto-responder (automated "I'm on Holiday till" or "I

got your message and will reply soon" type mails)

The exact definition of a bounce depends on your Blink Mailer configuration,
and it can take several days for a bounce to be registered on the system. An
email which continues to bounce will eventually be either unconfirmed or
added to a do-not-send list.

A high bounce rate may be a sign of poor list quality.

In this campaign there were 0 bounces.

Forwards
The third column FWDS shows the number of people who have forwarded the
mail through the Blink Mailer ForwardToFriend system. This is dealt with in
Advanced Statistics. 

"Views"
This is the most exciting of your statistics, but also the most misleading.

In this case, our email was "viewed" by 156 of the 621 recipients, which gives
us an open RATE of 25.12%. However, it is important to understand the
limitations of this statistic, so you don't become frustrated or disillusioned by
what may seem like low readership levels.

The VIEWS statistic:

• Tells us how many people were recorded opening their email (and
presumably read the contents)

• Tells us the minimum number of people who opened the email
• And gives us a rate that reflects the number of people opening an email

compared to other emails we send.
• Does not tell us exactly how many people opened the mail, or what they

did when they opened it.

An "open" is not always recorded.
The major cause of inaccuracy when recording views is image blocking. If
images/remote content are blocked by a subscriber's email software, then the
action of your subscriber opening the email cannot be reported back to Blink
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Mailer (or to any system). Image blocking is therefore quite commonly used as
a privacy feature by email and webmail clients.

Only when your subscriber clicks, for example Show Remote Content, is the
view recorded in your campaign statistics.

Still a useful statistic...
This inaccuracy is the same for everyone, no matter which software they are
using to send their campaign; any "open rate" averages you see discussed on-
line or in books are subject to the same rules.

It is difficult to estimate how much higher your real readership is, additionally
the inaccuracy rate will vary from campaign to campaign. If we bear this in
mind, we can still make some comparisons, for example "have I received more
views over several campaigns" and "how I compare to the industry average."

What's the difference? 
The difference between the real open rate and the statistic may be very
significant: in this case, a quick study found that only 1 in 3 of the customers
who bought the cat food in the hours after the email was sent showed up in
the open results, and the cat food offer was only advertised by email. In this
case, the real open rate could be more like 80%.
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Rate 
To compare performance across several campaigns you can use the RATE
statistic, which is the number of opens expressed as a percentage of the total
sent. In this first campaign, we had an open rate of 25%.

Over time, as our list keeps growing, we can still compare back to see if we are
keeping our subscribers interested. The rate statistic can also be used to:

• a/b test email titles and sending times
• to compare readership between lists
• and even to benchmark performance against industry averages. 

Summary
This Statistics Overview page is useful for comparing and contrasting the
success campaigns. This can help you to improve your future campaigns.
However, the statistics should not be taken too literally. 
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Growing & using
complex lists

 

Understanding subscribers &
lists
It is important  to understand the nature of Subscribers and Lists in Blink
Mailer. 

What is a subscriber?
A subscriber is usually someone who is a member of one or more of your lists.
They may have subscribed themselves though a subscribe page, or you may
have imported their details from another source.

It is important to understand, however, that a subscriber may not be on any
list. This happens when you:

•Import subscribers but do not assign them list membership
•Delete all the lists a subscriber was a member of (without deleting the
subscriber)

What is a subscriber profile
All the data about a subscriber is stored in their subscriber profile.

This profile can be found by searching for their email in Subscribers > Search
Subscribers. To see all subscribers search for @.

Here are some examples of the kind of data held in a subscriber profile:

On the Details page you can see information like ID, email address, confirmed
or not, blacklisted or not, number of bounces and html or text emails. Some of
this information is editable.
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By clicking on the Lists tab you can see the lists which the subscriber is a
member of, and you can edit this too.

By clicking on the History button you can see all the campaigns that have been
sent to the subscriber.
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By clicking on the numbers in the CLICKS column you can see detailed
information about which images and text links they clicked on, when and how
often. 

As you can see, the subscriber profile is the central place where all information
about a subscriber is stored. This is very different to list membership.

What is a list? 
A list is a way of grouping together subscribers so you can send them
campaigns. However the list itself does not contain the subscriber details. As
you have seen, all that information is in the subscriber profile.

You can view your lists by going to Subscribers > Subscriber lists from the
main menu. Next to each list is the number of MEMBERS that list has.
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However, if I delete the list, I have not deleted the subscribers. 

Some examples of how this works in practice 

A useful tool to help understand lists and subscribers is the All
subscribers feature, which was added in version 3.0.8. When this feature is
enabled (in the config.php file) you can see the total number of subscribers
shown alongside your lists.

Let's do some experiments with adding and deleting lists to see what happens
to the All Subscribers total.

At the start of our test, the number stands at 5327. That means we have 5327
subscriber profiles in our system all together.
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If we create a new list, and paste in the emails of some of our subscribers,  we
can add these subscribers to the list and send Campaigns to just a sub-section
of our total number of subscribers.

 

The outcome is a new list (in this example with 662 members). However, you
can see that the All subscribers total stays at 5327. This is because we have
not added any new subscribers, we have just created a list out of current
subscribers.

 

Now, if we delete the new list with its 662 members,
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the All subscribers count does not go down either, it is still 5327.

 

We can repeat this test, but this time add a mixture of current subscribers (2)
and new subscribers whose data we have never introduced to Blink Mailer
before (8). You can see Blink Mailer processes all the lines, imports 8 new
emails to the system and marks 2 as duplicates. 

 

All of these emails are added to our new list, and additionally, our All
subscribers count goes up by 8 subscribers to5335. 
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We have added 8 new subscribers to the system, and Blink Mailer has created
8 new subscriber profiles for us. If we delete our new list again...

 

The List is deleted, however the subscriber count stays at 5335. We have only
deleted a list, we have not deleted any subscribers.
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How to delete subscribers
You should not delete subscribers in most circumstances. If a subscriber wants
to stop receiving emails from you they can unsubscribe. Unsubscription means
that:

• Their email will be kept on the system and added to a do-not-send list
(blacklist)

• Your Blink Mailer system will never send a campaign to them again,
unless they re-subscribe

• If you import their email again (by accident) you will not be able to send
them campaigns inadvertently

• You have a record of when/why they unsubscribed which you can use to
improve your campaigns in the future

If you are in a situation where you want to delete some subscribers rather than
simply blacklist them, for example, to bring the size of your lists down, first try
the options on the Reconcile page, for example to remove those with x number
of bounces, those with an invalid email and those who are not-confirmed.

The final resort is to get some emails by exporting them (from Export
subscribers) and then pasting whichever emails you wish to delete into the
bulk delete function. This can be found though the Manage Subscriber page.

Creating your lists
In Blink Mailer you can organise your subscribers into lists. You must have at
least one list.  You may find that having multiple lists, that is, Segmenting your
list, improves subscriber satisfaction and opens/clicks.

There are several factors to be aware of:

• You must select at least one list when sending
• You can select several lists or use the all lists function when sending
• Subscribers will never get the same campaign twice, even if they are on

several of the lists you select
• Lists can be categorised to help you keep organised
• Lists are not the same as Attributes

Now that you know the basics, it's time to get started.  
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Go to your lists page
Go to Subscribers > Subscriber lists from the main menu. 

 

This will take you to your SUBSCRIBER LISTS page, where all of your lists will
be displayed.

There are two lists by default, test and newsletter.

You can view lists by category, or view lists which have no category by
selecting Uncategorised from the dropdown menu.
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Add a list
Click the Add a list button at the top of the page. 

Fill out the details using the guide below to help you.

List Name
This will help you to keep your lists organised and remember what the list is
for. If your list is public this name will be displayed on your subscribe pages. If
your list is private, the name will be known only to you (and possibly to other
people who manage your Blink Mailer installation). 
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Public List
The Public List box should be checked when

• You want subscribers to be able to add themselves to the list using a
subscribe page

• You want subscribers to be able to leave this individual list (but stay on
others)

• You have chosen a list name and description which you are happy to
display publicly

If you do not make the list public, it is considered private, and it will not be
seen by your subscribers. 

Category
Categories can be used to help organise your lists. If you decide to use them
there is lots of information in the categories chapter, however, here is a
summary:

• If you have no categories then the category dropdown will not display on
this page

• You must use categories if you have more than 16 lists
• If you have some categories already but you want to leave this list

uncategorised then simply leave  -- Choose category in the dropdown

In this instance we had already set up some categories and chose the
category Gardening from the dropdown.

List Description 
This information will display on your subscribe pages if the list is public.

Save and repeat 
When you have filled out the page click Save. You can come back and edit the
info again later if you need to. You can create as many lists as you need. 

You will be prompted to add some subscribers to the list. See the next
chapters for more guidance.
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Adding subscribers to lists
There are three main ways to add subscribers to your Blink Mailer installation:

• copy and paste a list of emails
• upload a file with emails 
• upload a CSV file with emails and additional data. 

This chapter deals with each of these methods in three stages

• When and why you might use the import method
• Preparing your data
• Importing your data 

Why is (to lists) in brackets? 
It is important to remember that:

• Subscribers can exist on the system without being a member of any list
• In this chapter it is assumed that you will be adding subscribers in the

form of a list, but you can add them without making/choosing a list if
you want to

• When you add a subscriber to the system for the first time, a subscriber
profile is created

• Adding the subscriber to more lists does not create more profiles, all the
subscriber details are saved in one profile no matter how many lists the
subscriber is on

• Deleting the list does not delete the subscribers.
You can read the chapter about the difference between subscribers and lists for
more information. 
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Copy and pasting 
Why and when to use this method 

If your data is very simple, just a long list of emails in a paper or digital
document, then this could be the method for you - especially if you are not
very confident with file formats.

If the emails are on paper then you could type them directly into the import
dialogue, however, it is probably better to type them into a document first.

This is also the method you will use when you create a new list from
subscribers that are already on your system.

Preparing your data for this method

Preparation for copy and pasting the emails in is minimal. You may need to do
nothing at all.

If your emails are in a text file or a word-processing file, you need to open the
file with the emails in, and make sure the data is just a list of emails, one on
each line and with no punctuation.

If your emails are in a spreadsheet or csv file you do not need to prepare
them. However, if this is the first time you will be adding the subscribers to the
system you may wish to use a csv import to allow you to add more of your
data to their subscriber profiles.

Importing your data 

If your data set consists of a list of emails in a file, like this:
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Or a complex data set in a spreadsheet like this, from which you only wish to
upload the emails

Then first you need to select them in your document and copy them. This is
often done by pressing:

Control+C or
Right click > Copy or
Edit > Copy.

Then go to Subscribers > Import emails from the main menu 
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Click the copy and paste list of emails button in Blink Mailer 

  

You will then see the following page:  

First choose a list by ticking the box next to the list name.

You may also Add a list, or tick All Lists. Also, it is best to leave the Check to
skip emails that are not valid box ticked. Next, paste your emails into the box,
using 

• control+v
• Or right click and Paste. 

pg 47



  Growing and using complex lists

  

Click the Import emails button.

You will then see the results of your import.

 

Upload a file with emails 
Why and when to use this method 

If you have a digital list of emails with no other data, and you know how to
save them as a text file, then this is the right method for you.

If you have more than just emails in the file and you want to upload all of the
information, you will need to use the CSV import. 
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Preparing your data

Your file needs to be formatted:

• One email per line
• No spaces, tabs, commas etc. 
• You need to save it as plain text (filename.txt) 
• You should only edit it in a text editor such as NotePad, TextEdit or

Geany.

It is still possible to import this data when there is additional information after
the email, for example:

FinelyMay@einrot.com age 23 from Southport likes chips with curry sauce

But, everything after the end of the email will be discarded. Additionally, if you
have any punctuation attached to the end of the email, for example,

FinelyMay@einrot.com, age 23 from Southport likes chips with curry sauce

then the data will be corrupted because the comma at the end of the email
address will be imported as part of the email.
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Importing your data 

Go to Subscribers > Import emails from the main menu 

 

Click Import by uploading a file with emails.  
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You will then see the Import Subscribers From Text File page.

First choose a list by ticking the box next to the list name. You may also Add a
list, or tick All Lists. Then select a file to upload by clicking the Browse...
button. Navigate to the file on your computer and click Open. Then click the
Import button.  

 

You will see the emails importing.
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Upload a CSV file: emails and some additional information
Why and when to use this method 

This is the method used when you have a spreadsheet full of data, where there
might be names, emails, addresses... Often this data will have been exported
from another source, such as a CMS, CRM, webshop, database or email
address book. 

If you have such data, it is a good idea to upload a CSV file the first time you
add subscribers to the system and you are asked to make a list (even though
you will only be prompted to copy and paste). From then on, unless you need
to re-synchronise or add some new data, you can just use copy and paste to
add subscribers to lists.

Preparing your data 

When you have emails and some additional information, such as Name and
Gender, you need to

• Open the data in a spreadsheet
• Rename some columns to avoid or utilise Blink Mailer system values
• Save as a csv - make a note of the delimiter.

Example Dataset for CSV Import

In this example we have ID, title, first name, email address, height in cm and
gender, and they are stored in a spreadsheet format (xls, ods or similar).

Data that includes an ID

When you use another application, a blog, webstore, CRM software etc, you
may want to keep the data in Blink Mailer synchronised with the data in your
other app.

Blink Mailer allows you to do this accurately by using a foreign key: this means
that the ID tag or number used to identify an individual in your other
application can also be used to identify the subscriber in Blink Mailer. This
means that:
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• If a subscriber's email address changes in your other app, this can
be updated in Blink Mailer 

• Any changes to subscriber attributes can be updated automatically,
for example surname, location, date of last purchase from your
store.

If you wish to use the ID as a foreign key you should rename the column ID
(or similar) to foreign key.

Renaming columns to avoid Blink Mailer system values

Some words are already used by Blink Mailer to describe data: these are called
Blink Mailer system values. Blink Mailer will not allow you to import data from
columns in your CSV when certain system values are used as a column title.
These columns will simply be skipped when you try to import.

It is common for other software and web applications to use the same system
values. Columns must be renamed before the data exported from one app can
be imported into Blink Mailer. Here are some examples (a full list can be found
later in the chapter):

• ID 
• confirmed
• passwordchanged   

Renaming columns to match Blink Mailer system values

Some columns can be renamed to match Blink Mailer system values, because
those system values are designed to take imported data.

In the example below we rename the column Email address to Email. It is
possible to achieve the same thing during import by mapping one term to
another.

As another example, the ID column can be renamed to Foreign Key. This
allows the data to be put to use in Blink Mailer when otherwise it would just be
skipped. In this case, Blink Mailer would not allow you to map ID to Foreign
key during import so this task must be done before upload. 
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A list of system values 

Here is a table containing a list of all the system values and how Blink Mailer
will deal with columns with that name if you try and import them. 

List of system values and how Blink Mailer will respond if they are column
names.

 

id Will be skipped

email Will import

confirmed Will be skipped

blacklisted Will be skipped

optedin Will import

bouncecount Will be skipped

entered Will be skipped 

modified Will be skipped

uniqid Will be skipped

htmlemail Will import

subscribepage Will be skipped

rssfrequency Will be skipped

password Will import

passwordchanged Will be skipped

disabled Will import

extradata Will import (as attribute)

foreignkey Will import

unique_1 (2, 3 etc) or 
index_1 (2, 3 etc) Will be skipped
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Saving the file

Next we need to save the file as a CSV file, a comma separated value file. You
should ideally change the delimiter to tab. If it is not tab, you will at least need
to be aware of what the delimiter is so you can tell Blink Mailer when you
import.

Importing the subscribers 

First go to Subscribers > Import emails from the main menu. 

Click the final option for import by uploading a CSV file with emails and
additional data. 

  

You will then see the Import Subscribers From CSV Page.
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First choose a list by ticking the box next to it. You may also choose All Lists or
Add a list.

Next upload your CSV file by clicking Browse..., choosing the file on your pc
and clicking Save. 

You must also indicate the delimiter, this is what separates each item in your
CSV (in place of the column lines). If you are unsure what the delimiter of your
file is, you can open the file into a plain text editor such as Notepad. You will
see what is separating the items. In this case it is a comma, so we put a , in
the Field Delimiter box. 
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There are various other options on this page, which all have a description.
Generally, it is good to keep the Test Output option checked.

Use the Overwrite existing and/or Retain old email options to preserve the data
set which should be held safe; it is the source of most up-to-date data.

When you have finished filling out this form, click Import. 

You will now see a page where you can match the data in your file to attributes
on the system. Attributes such as Foreign Key and Email will not appear on this
page because the system deals with them automatically: all the attribute on
this page are new to the system. 
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Click on each dropdown - is the correct attribute already in the list? If not,
select Create new one. This will create a new attribute in your Blink Mailer so
that next time you import similar data the system can deal with it
automatically.

Problem? If you see something like the image below, where all your attributes
are on one line, then you have used the wrong delimiter.  

You will also see some test data, that will give you a strong indication of
whether your import is going well. Each column title from your csv should line
up with some data about one of your new subscribers.
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Problems?

If you see anything wrong in the test, do not proceed! Click the Reset import
session button to start again, check your delimiter settings and/or get help. A
messy import is no fun to fix! 

When all attributes have been dealt with and you are happy with your test
data, click Continue.

You will be shown a summary of what will happen when you import. Now you
can see that Foreign Key and Email are matched automatically, and all your
other attributes will be created for you. 

If you are satisfied, click Confirm Import.
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You will see that your subscribers and their data has been imported.
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Creating a subscribers page
A subscribe page usually consists of a short form that a visitor to your website
can fill out to subscribe themselves to one or more of your lists. Here is an
example:

In the example above, the subscriber is asked to input their email address and
to confirm it. They can then choose to receive a text version format and they
can add their first and last names if they wish. 

In Blink Mailer you can have an unlimited number of pages, combining any set
of Attributes, Lists and Languages. 

Additionally you can use pages in conjunction with scripts to create subscribe
forms which integrate more closely with your website. As this is a custom-
made process for individual sites we do not have generic documentation about
it.

Create a page 
To get started with your subscribe page visit Config > Subscribe Pages.
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Initially you'll find this page empty, with no subscribe pages to display,
although there is a default subscribe page at www.yourdomain.com/lists.

The first page you make will replace this default page and later you can set
any page as default. 

To create a new page click Add a new subscribe page.

 

This will open a page called EDIT A SUBSCRIBE PAGE. 

Customise a Subscribe Page
The subscribe page editor is broken into four collapsible areas:

• General information
• Transaction messages
• Select the attributes to use 
• Select the lists to offer

 

These sections will guide you though creating a subscribe page which meets
your specific needs.

General information
The first box edits the titles and text on the page. Enter your title in
the Title box first of all.
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You can leave Language file to use as --default, unless you are creating a page
for a language other than the one you use for your installation, for example, if
you are creating a multi-lingual system.

You can change the text in the intro too.

 

The Header and Footer dialogues are used for html editing, and the
default code in them is taken from Config>Settings>subscription-ui settings.
We will discuss this further in the Subscribe page design and configuration
chapter. 

You can edit the text in the Thank you page and Text for button too, however,
the standard texts are suitable for most situations so you may wish to just
leave the defaults as they are.

General Information: HTML or Text
The last section of the general information sections is on HTML Email choice. It
is very important and it directly affects the quality of your lists and the
subscribe satisfaction. 
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You can create a HTML email in Blink Mailer, with images and other design
elements, and also a plain text version, with just text, no images, colours etc. 
Some subscribers prefer only text, they may want plain text for technical
reasons, for example for compatibility with assistive software for a visual
impairment, or it may simply be a personal preference. 

If you are planning on sending HTML messages you will want to avoid large
numbers of your subscribers accidentally signing up for text only emails. You
will have wasted time on a design they will never see and they may be less
interested in your mails.

It is therefore worth spending time on this section, deciding how you would
like to present the text vs. HTML options.

The default (as of version 3.0.11) is Offer checkbox for text, where the box
defaults to unchecked on the subscribe page. This means your subscribers will
have to manually choose to receive text emails, but the option is there for
those who need/want it. 

If you intend to send emails in HTML format it is best to make the "path of
least resistance" be the signup for HTML. Many subscribers will ignore the box,
or may not know what HTML vs. text means.

Transaction messages
These are the messages sent to the Subscriber based on various actions, such
as subsc r ibe and unsubsc r ibe . The de fau l t s a re taken f rom
Config > Settings > transactional settings. It is possible to edit these, although
the defaults are suitable for most situations.

Select the attributes to use 
This section allows you to choose which attributes, which personal/
demographic data, you will ask for from your subscribers on the page.

You might ask for generic information like name and city, or something more
specific, like shoe size or hobbies. The use of attributes is described in the
Attributes and Placeholders chapters.
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In this example we collected First Name and Last Name only and we did not
make either of them required because many people do not wish to give out
personal information. We had several other attributes to choose from.

The Type: is defined in the attributes editor. The Default value can be different
on each subscribe page if needed.

Please note that if a customer does not change the Default value when they
subscribe, whatever you set it as here will be added to your database.

Select the lists to offer
This final section allows you to select which lists to offer.  

If you select only one list, then the subscriber will not be given a choice. If you
select multiple lists, then the subscriber will be able to select which lists they
want to join. In this example we chose only one list.
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Save your new page
Click the Save button at the end of the page when you are ready. You will be
able to edit the page again later if you want to make a change.

You will then be directed back to your Subscribe Pages list. We can now see
one page. 

View your page
To view your new subscribe page click the magnifying glass icon next to it on
your subscribe pages list (Config> Subscribe pages from the main menu).
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Your page will look something like this:

 

Use your page to add a subscriber as an admin 
One additional functionality of the subscribe page view is to add a subscriber to
your database quickly, without needing to go into the administrative interface.
If you view the subscribe page while logged in as an adminiatartor,  you will
see an additional box:

 

This box allows you to add a subscriber by filling out the form on their behalf,
and you can specify if you need to send them a confirmation request or not.
This can be useful if you are talking to the new subscriber on the phone, for
example.
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Setting up your list 
categories
When you have more than a handful of lists you will need to organise them
into categories. You will be prompted to do this once you create more than 16
lists.

You can create categories to help you organise your lists at any time, and so
the exact method you should use depends on your situation. In this chapter
there are two suggested workflows.

1. Categories are set up before any lists are made (categories before lists).
2. Categories are set up to help organise pre-exisitng lists (lists before

categories). 

You should follow the section most appropriate to your situation. 

Categories before lists
To create your categories go to Config > Settings

Scroll down until you find Segmentation settings 
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Enter the names of your categories, separated by a comma.

In the image above you can see I have made a list category called veganism,
for example. This is because I know I will have several lists about veganism in
the future, for example, recipes, campaigning, events and philosophy.

NEXT, See the section about Using categories at the bottom of the page. 

Lists before categories
If you use Blink Mailer a lot and you are using list segmentation you will soon
end up with more lists than you can easily manage without categorising. To
start categorising your lists go to Subscribers > Subscriber lists. 

Then click Categorise lists. 
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If you have no categories at all yet, you will see the following screen:

Click  Configure categories.

If you already have a few categories you will see a similar screen with the
Configure categories button (which you still must click) in the top right.

Create your categories 

Add your categories, one by one, with commas between them. 

Click Save Changes.
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Add lists to categories
Go back to Subscribers > Subscriber lists. Click the Categorise lists button.

Select the correct category from the drop-down beside each list.

If a list is already categorised, it will not be displayed. 

Carry on till all the lists are matched with a category if possible. 
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If you find a list that does not fit into a category you can keep it in
Uncategorised by leaving --Choose category in the dropdown and make a new
category later.

When you have finished click Save. Then, if you want to create more
categories click the Configure categories button at the top of the page again
and repeat the cycle. 

If a list has already been categorised and you want to change the category,
you can do this by editing the list from the main lists page. 

Using your categories
Once you have finished setting up categories, they should become part of your
everyday workflow with Blink Mailer.

For example, when you make a new list, you can assign it to a category during
the creation stage. In this image I have created a list called Vegan Recipes and
I can categorise it under veganism. 

Also, as a second example of categories in use; when you send a campaign
you can look for your lists by using categories too.
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Using attributes
Blink Mailer is pre-configured to deal with some data about your subscribers,
for example email address, number of bounces (bouncecount) and their Blink
Mailer ID number: these are called system values. Attributes are used for any
other data you want to add to the system about your subscribers, usually
demographic information.

Some common attributes are Name, Age, Gender and City. Some bespoke
examples could be height, annual income, names of pets or kids and favourite
genre of book. The attributes you use are entirely up to you to decide.

Once you have collected/uploaded attribute data, it can be used to connect to
your subscribers more directly and with better precision, by using placeholders
and the segment plugin.

There are two ways to create attributes:

• Create them in bulk when you import a csv file
• Create them manually from the configure attributes page
• Edit them from the configure attributes page

This chapter will explain how to create attributes. How to use them is covered
by the placeholders chapter and the segment plugin documentation.

Creating Attributes when importing data
When you import complex data using the "csv with additional data" method,
attributes can be easily created (in bulk) from column titles which are not
already listed as an attribute.

Do not create new attributes for email and other system attributes, you must
map those to the pre-existing system attributes listed in the dropdown.

In the image below, five new attributes are being created, and EmailAddress is
mapped to Email.

Surname and Gender are standard attributes, however, the subscribers' height
in Centimetres is more unusual. Blink Mailer treats all these attributes in the
same way: there are no restrictions on the subject matter of an attribute.
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Once an attribute has been created, any column headed with the attribute
name in future csv files you import will be mapped to the attribute
automatically. You will not need to create the attribute again.

If there is new data for a pre-existing subscriber, it will be integrated into the
subscriber details by using email address or Foreign Key as a reference.
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In the image below, for example, we have subscribers on the system already,
and now have added ShoeSize as a new attribute. Where our new dataset
provides a shoe size for a pre-existing subscriber, this new attribute data is
simply added to the details.

 

Creating and editing attributes on the Configure attributes 
page
To create or edit an attr ibute manually, go to Config > Configure
attributes from the main menu. 

From there you can create a new attribute:
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You can also edit existing attributes:

 

You can,

• Specify/change the name
• Choose/change the Type, which dictates the input method on your

subscribe pages (see the example edit below)
• Choose/change the Default Value, which dictates the standard value on

the subscribe page (you may need to change this on the Subscribe page
editor too)

• Make the attribute required, so subscribers must give the information in
order to sign up (warning: mandatory fields may deter subscribers)

Additionally you may,

• tag them to delete one or more attributes
• tag to merge several attributes together
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Example edit 1: changing the type from textline to select 
In this example we will change the Type of the attribute for ShoeSize, which
was automatically created during a csv file import, from textline to select. First
we change the type to select using the dropdown menu, then we click the Save
changes button at the bottom of the page.

 

Then we click the edit values button which appears below the Type: dropdown.

We can then add all the shoe sizes we want.

If you are editing an attribute that already has data in the system, some
values may already be listed: if you try to add these again Blink Mailer will skip
them rather than create a duplicate, so you can simply list all the values you
want rather than search through.
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You can change the order of the values for the attribute. This will affect the
order in which they are listed in the dropdown on the subscribe page. In this
example the shoe sizes had become jumbled because some were already in
the system and some were not,  so we re-ordered them.

 

By changing the order, the choice given to subscribers when they sign up is
clearer.

  

Using Attributes 
The primary use of attributes is as placeholders. Please see the placeholders
chapter for information on how to use them. The segment plugin and
the attribute select plugin allow you to send emails to subscribers with certain
attribute values.
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Using placeholders
A place holder is a word in square brackets, for example,

[FIRSTNAME]

or

[UNSUBSCRIBE] 

which will be replaced with real data, such as the subscriber's name or a
unique URL during sending.

Placeholders in Blink Mailer 
There are three types of placeholder in Blink Mailer:

•System e.g. [UNSUBSCRIBE]
•Config e.g. [WEBSITE]
•Attribute e.g. [FIRSTNAME]

In this chapter we will deal with the Attribute placeholders only. We will deal
with system and config placeholders in the templating and configuration
chapters respectively.

Where to find a list of Attribute placeholders
When composing a campaign, you can find a list of placeholders by clicking on
the information symbol, i, next to the text Compose Message.

 

Any Attribute placeholders will be listed here along with instructions on how to
use them.
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These are generated directly from your chosen Attributes so if you wish to edit
them, please see the Attributes chapter. 

How to use a placeholder in a mail 
To use a placeholder, you need to type it exactly as suggested in the
information, i, box. This will include:

•an open square bracket
•the placeholder name (in Capitals, with spaces) 
•and a close square bracket

It is also wise to use some fallback words, that is words that will be inserted in
place of the data when the data is missing. You can indicate the fallback
words with the double percent sign %%. Anything before the %% is the
attribute placeholder. Everything after the %% is the fallback text. The fallback
text is optional. 

In this example, the placeholder would either print the subscribers' first name,
and where the name is not known, it will print the word Friends.
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It is important that you test your placeholder before you send your mail, as
mistakes are ugly and disconcerting for your subscribers.

Set up two test accounts
To test your placeholder effectively you will need:

• one subscriber profile suitable for testing the attribute placeholder. You
can use an alternative email to which you have access, where the
attribute data is completed

• another subscriber using an email you have access to, where the
attribute data is not completed.

You may need to add these emails or edit your existing data to achieve this.
You can do all these things from the Search > Search Subscribers page.

In the example below I have subscribed myself to the system using my
personal email (rather than my work email) and I have filled out my name.

And I have another one using my old email address where the attribute data
has not been provided.

Send a test message
Next, enter the two test emails into the Send Test box at the bottom of your
campaign Content page and press Send Test. You may need to confirm the
emails if it is the first time you have used them.
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Check the results
For the subscriber where the attribute related to the placeholder has data, you
should see that data in the email. In this example you can see the name Anna
is visible in the place of [FIRST NAME]

 

Where the subscriber has no data for the attribute, you should see the Fallback
Text. In this example that is the word Friends.

 

You can now send your campaign as usual.
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Targeting the campaigns: 
list segmentation
In this example, Ethical Pets are sending out a campaign about a special offer
on dog treats.  They are targeting the campaign by only sending it to
customers who have previously bought products for a dog. 

There are several reasons for doing this:

• It enables more campaigns to be sent overall, which increases the
impact of email marketing

• Most people will receive fewer campaigns, so they are not inundated
• Campaigns will be more relevant to readers
• Campaigns are quicker and easier to write, because they only need to be

interesting to the target audience and not to everyone
• It is easier to measure the impact of the campaign

In this campaign only 35% of the total number of subscribers were emailed.
Without segmentation either a large number of people would have received a
campaign with little relevance to them or Ethical Pets would have needed to
spend time tying to make the campaign have a broader appeal. 

The overall consequences of segmentation should be: 

• Happier customers
• Fewer unsubscribes
• More motivated marketeers
• Improved sales/responses to calls to action
• Improved customer loyalty/retention over time

Segmenting your list
The method of segmentation depends on,

• The quality of your data
• Where and how your data is stored
• What tools you have to segment it
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In this example the segmentation was achieved using a Prestashop plugin,
which allows the exporting of customer details based on the category of
product bought.

Unfortunately the Prestashop core does not provide very detailed data exports,
and so a paid plugin was needed.

In other situations it may be possible to segment a list using:

• spreadsheet software
• database software
• the Blink Mailer segment plugin, to split the list using attributes

Adding a segmented list to Blink Mailer
A suggested methodology for adding a segmented list to Blink Mailer is:

• Synchronise your data - upload any new subscribers to Blink Mailer
• Create a new list
• Copy and paste the segmented emails into the new list
• Blink Mailer will pull in the rest of the data/attributes for you from the

subscriber profiles

Having synchronised the data by uploading the latest data using a csv import,
Ethical Pets went on to create a new list.
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In this case a new list Dog category purchasers was created (note: a private
list, not public)  

Then the emails from the prestashop segmentation export were pasted in:
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The segmented list of subscribers are now all members of the list.

Sending to a segmented list
The process for sending to segmented lists is the same as sending to large,
unsegmented lists. You simply select the list on the Lists tab of the campaign
workflow. In this example we have put the segmented list in a category too.
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Excluding a list
If you are sending a lot of mails and there is a chance that subscribers are in
multiple segments and receiving lots of campaigns, you could consider using
the exclude list functionality.

For example, if Ethical Pets wants to send a campaign to a list of cat product
purchasers just a few days after they sent the email to dog product
purchasers, they could exclude anyone on the dog list from receiving the cat
related campaign.

While this involves prioritising which campaign is most important, the dog or
the cat one, it means that the people who buy both dog and cat products are
not receiving too many campaigns in total.

Activate the list exclude feature 
Please contact Blink and ask us to activate this service within your config.php
file.

Using the list exclude feature
In this example, Ethical Pets have sent an email to the cat product purchasers
segment but excluded the dog purchasers segment. During sending Blink
Mailer checks if the subscriber on the cat list is also on the dog list, and if they
are, the email is not sent to them.
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Additional ways to segment a list
Here are a few ideas for ways you could segment your lists:

• Subscriber location
• Subscriber interests
• Subscriber demographic (gender, age, shoe size etc)
• Subscriber actions (purchase, abandoned cart, signed petition, recent

comment etc)
• Subscriber status (new to list, long-time member)
• Subscriber preference: ask your subscribers how often or when they

would like to receive emails from you using an attribute on your
subscribe page.

Additional benefits of segmentation 
There are many benefits to list segmentation:

• You can a/b test aspects of your email, for example the tone / style /
grammar of the subject line

• You can automate transactional messages, for example, messages
offering help to customers who abandoned a cart. You can use a
recurring campaign for this.

• You can tailor very specific emails, for example about events, to those
who live in the location of those events.

pg 88



 Designing and assesing your campaign

Designing and assessing
your campaigns

 

CKEditor Interface
CKEditor provides a clean and simple user interface. If you are familiar with
desktop word processors like Microsoft Word or OpenOffice.org Writer, you will
quickly see that using an online text editor is just as easy and intuitive.

Interface Structure
The figure below shows main building blocks of CKEditor:

The interface of CKEditor
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The editor consists of five main parts:

• Toolbar (1) – the section at the top of the editor containing grouped
menu buttons that give you access to various functions of CKEditor.

• Editing Area (2) – the space below the toolbar where you type your text
and add media.

• Context Menu (3) – a small pop-up menu with shortcuts to most
common operations available for the object, visible after a right mouse
button click or pressing the Application/Menu key on your keyboard.

• Elements Path (4) – the section at the bottom of the editor displaying
information about the HTML elements of the document (advanced
feature).

• Dialog Windows – small pop-up windows that appear when you use some
of the editor's functions and are opened by clicking the toolbar buttons.

Resizing and Maximizing CKEditor
CKEditor is usually embedded in a website, as one of its parts. If, however,
you would like to resize its interface, you can easily do it by clicking and
dragging the resizing grip in the bottom right-hand corner of CKEditor
interface.

To make writing more convenient, you can also maximize the CKEditor
interface in the browser window. When you press the Resizing and Maximising
CKEditor toolbar button, the CKEditor interface will fill the browser window and
stretch to its borders. If you want to return to the default view and minimize
CKEditor, press the same button again.

CKEditor Toolbar
The Toolbar is the section located at the top of the editor window. It contains
menu buttons that give you access to various functions of CKEditor. All buttons
are grouped according to their function and include both simple operations
(like basic text styling or formatting) and more advanced features (like
inserting media or forms via a dialog window).

This is what the editor toolbar looks like:

The CKEditor toolbar
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The CKEditor toolbar buttons are illustrated with meaningful icons. If, however,
you are not sure what functions they perform, hover the mouse cursor over
the buttons to see a tooltip with the name of the function.

Using the Toolbar
In order to perform an operation assigned to a button, click the button once. In
most cases it will either immediately perform some predefined action or open a
dialog window with further configuration options for a feature.

Remember that the toolbar can also be used with your keyboard. To enter the
toolbar, use the Alt+F10 keyboard shortcut. To move to the next or previous
button group, use the Tab and Shift+Tab keys, respectively. Within a button
group, use the Left Arrow and Right Arrow keys to move between buttons of
this group. To activate a selected toolbar button, press Enter or Space.

The accessibility shortcuts for toolbar navigation were modified in CKEditor 3.6,
when the concept of a toolbar button group was initially introduced. On
entering the toolbar you can now use the Tab and Shift+Tab shortcuts to
navigate between button groups and the Arrow keys to navigate between the
buttons within a group. In CKEditor 3.5.x and before both Tab and Arrow keys
were used to navigate between the toolbar buttons.

Some of the buttons serve as placeholders giving you access to further options
placed in a drop-down list. They are easily recognizable thanks to a small  
icon on their right. Clicking the name or the arrow icon of such button expands
the list and lets you choose one of its options via the left mouse button. To
select a drop-down list option you can also use the Tab or the Down Arrow key
and then accept your choice by pressing Enter or Space on your keyboard. To
hide the list, use the Esc key or click anywhere in the browser window.

Collapsing and Restoring the Toolbar
To save on screen estate, you can collapse the toolbar by pressing the  
button or using the Alt+- (minus) keyboard shortcut. In order to return to the
full toolbar view, press the same button or keyboard shortcut again.
 

Editing Area 
The Editing Area is the empty space below the editor toolbar where you type
your text. All formatting applied using the toolbar buttons as well as all
inserted media appear immediately in this area.
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This is what the editing area looks like after you type some text:

The CKEditor editing area

If the document contents span beyond the limits of the editing area, a
standard scrollbar will appear. To view the text that exceeds the size of the
editing area you can either scroll it using the scrollbar or maximize the editor
in the browser window using the  button.

WYSIWYG Editing
CKEditor is a WYSIWYG editor, which means that the text edited in it looks as
similar as possible to the results end users will see after the document gets
published. When you format your text using the editor features, the formatting
can be immediately seen in the editing area.

Formatting seen immediately in the editing area

Navigating the Editing Area
To easily move around the text you can use the keyboard.

Page Up and Page Down let you jump up and down the text. The Home and
End keys can be used to go to the beginning and end of line, respectively, or
combined with the Ctrl key — to the beginning and end of the document. You
can also move inside the text using the Arrow keys.
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Context Menu
The Context Menu is a pop-up menu that appears whenever you click inside
the CKEditor editing area with the right mouse button, use the Menu /
Application key on your keyboard, or the Shift+F10 keyboard shortcut. It
serves as a shortcut for most common operations available for a given type of
object.

The image below presents the context menu for a link embedded in the
document:

CKEditor's context menu for links

The menu is context-sensitive which means that the options displayed in it
depend on the object that you click.

If, for example, you press the right mouse button while inside a table, you will
see some table-specific options available in its context menu.

CKEditor's context menu for tables

Note that for some more complex objects, like a table, the context menu might
include sub-menus with further options. To open the sub-menu, go to the
menu option containing a small right-pointing arrow ( ) and either click it with
your mouse or use the Right Arrow key on your keyboard. To return to the
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parent menu, use your mouse or the Left Arrow key.

To perform an operation listed in the context menu, click it with the left mouse
button. You can also move up and down the context menu with the Up and
Down Arrow keys or the Tab and Shift+Tab combinations. Once an option is
highlighted, you can activate it with the Space or Enter button. If an option is
grayed out, like the Cut and Copy operations in the first screenshot, it is
unavailable unless some pre-conditions are met (e.g. an element is selected).

In some environments and browsers clicking the right mouse button results in
the browser context menu covering CKEditor context menu. If this is the case,
press the Esc key once to close the browser context menu and reveal the
CKEditor menu hidden below.

Elements Path
The Elements Path is the section at the bottom of the editor displaying
information about the HTML elements of the document for the position of the
cursor. It is an advanced feature aimed at users who want to have more
control over the source code of their document.

The elements path always shows a hierarchy of HTML elements for the
currently selected element of the document.

This is what the elements path looks like:

The elements path of CKEditor

The mouse cursor is now located inside the word "Second", so the elements
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path shows the following hierarchy of HTML elements: body (main document
element), ol (ordered list), li (list item) and strong (bold font).

Note that most of the same information can also be deduced from the state of
the main CKEditor toolbar since the formatting options that were applied to the
active element are highlighted.

CKEditor elements path can also be used to select elements. To achieve this,
click an element's name on the elements path with your mouse. You can also
use the Alt+F11 keyboard shortcut to enter the elements path, and then
navigate between the elements with the Tab and Shift+Tab (or Left and Right
Arrow) keys. To select an element with your keyboard, use the Enter or Space
keys.

Dialog Window 
Dialog windows are small pop-up windows that are displayed when you use
some CKEditor functions like Find and Replace or Insert Image. These windows
display various configuration options related to a particular feature and often
give you access to more advanced settings.

Dialog Window Structure
As an example, the Anchor dialog window is presented below:

Anchor dialog window in CKEditor

When a dialog window is open, the main editor window including the toolbar is
blocked.

All dialog windows contain the OK button that lets you confirm the settings and
return to the main editor window as well as the Cancel button that closes the
pop-up window without introducing any changes to the document.

Another way to close the dialog window and return to the editing area is to use
the X button located in the top right-hand-side corner of the window or to
press the Esc key on your keyboard.

Depending on the options available for a particular feature the dialog window
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may contain different elements. Some windows may also contain tabs with
additional configuration options. To navigate between the tabs simply click
their labels. You can also move between tabs with your keyboard. To enter the
tabs list, press the Alt+F10 shortcut while in the dialog window. To move to
the next tab, use the Tab or Right Arrow key. To go back to the previous tab,
press Shift+Tab or the Left Arrow key.

Reopening a Dialog Window
Some dialog windows can be used to insert an element, such as an image or a
table, into the document. After an element is added to the document, in most
cases it can be edited at any time by double-clicking or selecting it and clicking
the appropriate toolbar button again. The dialog window will re-open and you
will be able to introduce changes to the element's configuration options.

If you attempt to close the dialog window without saving the changes, you will
be prompted to do so:

An alert window prompting to save the changes made to an element

You can either proceed without saving your changes by choosing OK or close
the alert window with the Cancel button and save the changes.

Resizing a Dialog Window
CKEditor dialog windows all open with some default size. If, however, you
would like to resize a dialog window, you can easily do it by clicking and
dragging the resizing grip in the bottom right-hand corner of a dialog window.

The image below presents a default size of the Advanced tab in the Link dialog
window.
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Advanced tab of the Link dialog window in its default size

Since the text entered into some text fields (particularly the Style field) might
be longer than their default size, you may wish to resize the dialog window.
Use the Drag to resize feature to change the width and height of a dialog
window as needed.

Advanced tab of the Link dialog window after resizing
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Editing tools

Below you will find an overview of all features available in the default
CKEditor toolbar as per above image. The CKEditor allows you to design your
email campaigns with its various tools. For more information about each tool
please click on the link in orange found to the right of the description.

Working with a Document
 Button Description

View or edit the source code of the document (for advanced 
users). See Document Source.
Save the contents of CKEditor and submit its data to the server, 
when CKEditor is placed inside an HTML form. See Saving 
Content.
Clear the editing area and create a new page. See Creating a 
New Page.
Show a preview of the document in the shape that will be 
displayed to end users. See Document Preview.
Select a layout template. See Templates.
Cut the selected text fragment to the clipboard. See Cut.
Copy the selected text fragment to the clipboard. See Copy.
Paste content copied to the clipboard along with formatting. 
See Paste.
Paste content copied to the clipboard without formatting. 
See Paste as Plain Text.
Paste content copied from Microsoft Word or similar applications 
along with formatting. See Paste from Word.
Print document contents. See Printing.
Insert a page break. This only impacts the printed version. 
See Page Breaks.

 
Check spelling of the document text or turn on the Spell Check 
As You Type (SCAYT) feature. See Spell Checking.
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 Undo or redo the most recent action performed. See Undo and 
Redo.
Find a word or phrase in the document. See Find.
Find and replace a word or phrase in the document. 
See Replace.
Select all contents of the document. See Text Selection.
Remove the formatting of the selected text. See Remove 
Format.
Maximize the editor in the browser window. See Resizing and 
Maximizing CKEditor.
Highlight all block-level elements in the document. See Show 
Blocks.
Show information about CKEditor. See CKEditor Version.

Text Styling
 Button Description

Apply bold, italic, underline or strike-through formatting to the 
text. See Bold, Italic, Underline, and Strike-through.
Apply superscript or subscript formatting to the text. 
See Subscript and Superscript.
Apply pre-defined combinations of various formatting options to 
block and inline elements. See Formatting Styles.
Apply pre-defined block-level combinations of various formatting
options. See Paragraph Format.
Change the typeface of the text. See Font Name.
Change the font size of the text. See Font Size.
Change the color of the text. See Text Color.
Change the background color of the text. See Background Color.

Text Layout
 Button Description

Increase or decrease text indentation. See Text Indentation.
Format a block of text as indented quotation. See Block Quote.
Create a new div element in document source. See Creating Div 
Container.

 
Set text alignment (left, centered, right or justified). See Text 
Alignment.
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Set text direction as from left to right (default value for most 
Western languages) or from right to left (languages like Arabic, 
Persian, Hebrew).
Insert a divider line (horizontal rule) into the document. 
See Horizontal Line.

Rich Text
 Button Description

Create a numbered or bulleted list. See Creating Lists.
Create or remove a hyperlink in the text. These features may 
also be used to manage file uploads and links to files on the web
server. See Links, E-Mails and Anchors.
Insert a link anchor to the text. See Anchors.
Insert an image into the document. See Inserting Images.
Insert an Adobe Flash object into the document. See Inserting 
Flash.
Create a table with the defined number of columns and rows. 
See Creating Tables.
Insert an emoticon image (smiley or icon). See Inserting 
Smileys.
Insert a special character or symbol. See Inserting Special 
Characters.
Insert an inline frame (iframe). See Inserting IFrames.

Form Elements
 Button Description

Insert a new form into the document. See Creating Forms.
Insert a checkbox into the document form. See Checkbox.
Insert a radio button into the document form. See Radio Button.
Insert a text field into the document form. See Text Field.
Insert a multi-line text area into the document form. See Text 
area.
Insert a selection field into the document form. See Selection 
Field.
Insert a button into the document form. See Button.
Insert an image button into the document form. See Image 
Button.
Insert a hidden field into the document form. See Hidden Field.
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Templates
The templating system in Blink Mailer is designed to create a workflow that
keeps things simple for the campaign creator.

The Templating Workflow in Blink Mailer 
There are two elements to the workflow:

1. Creating and uploading a template; this is done very rarely
2. Choosing and using the template; this is done for every campaign

Step one is the more complex and it is often done by a web designer or system
administrator. We cover this in the creating a template chapter.  There is also
a really easy templates chapter to help you if you do not have a designer. 

The second part of the workflow is very simple. The person creating the
campaign simply selects the template by name from a drop down menu after
the campaign message has been written.

The template is then applied during sending, like a wrapper around the text,
and the person sending the campaign does not come into contact with the
template code at all. 

The template is not applied to emails sent to subscribers who request a plain
text email.

pg 101



 Designing and assesing your campaign

An infographic about templating in Blink Mailer
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The footer
The Blink Mailer footer

• Is an active feature of the software, not simply a description of a design
element

• Can be edited for each campaign from the content tab of the campaign
workflow 

• Is replaced by a secondary footer when the Forward to a Friend system
is used

• Should contain the [UNSUBSCRIBE] placeholder 
• Is placed in the template with the [FOOTER] placeholder

What is the footer?
In your template design you may have many elements which you think of as
being "the footer." In the image below, for example, the blue and black
coloured areas and all the content within them would commonly be described
as the "footer."

However, you may not wish to add all of this into your Blink Mailer footer. For
example, in the image below only the "update your preferences" and
"unsubscribe" elements are within the Blink Mailer footer system. The rest is in
the template itself.

 

You may wish to choose which items go into the Blink Mailer footer carefully
because:

• The footer can be edited from the campaign composition tab: you may or
may not want certain items to be edited on a campaign-by-campaign
basis

• If the forward to friend placeholder is used, all content in the Blink Mailer
footer will be replaced when the message is forwarded.
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Adding your footer
Everything that goes in the Blink Mailer footer is added separately from the
rest of the template. 

To situate the footer to your template use the [FOOTER] placeholder.

 

You should design your footer as a separate .html file

 

To add your footer to Blink Mailer go to Config > Settings and campaign
settings
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Find Default footer for sending a campaign then click the edit icon

 

Paste in your footer code and click Save changes. 

 

Your footer will now appear in the footer section of the content tab in your
campaign workflow, where you can tweak it.

pg 105



 Designing and assesing your campaign

 

As well as in your campaigns when you send them

The Forward to Friend footer
On the Config > Settings page, there is a second footer called Footer used
when a message has been forwarded.

If you use the [FORWARD] placeholder, and a subscriber forwards the email,
this footer will replace the usual one. It contains the following text:

This message has been forwarded to you by [FORWARDEDBY].

You have not been automatically subscribed to this newsletter.

If you think this newsletter may interest you, you can [SUBSCRIBEURL] and
you will receive our next newsletter directly to your inbox.

If you wish to use the forward to friend system you should edit this footer so
that it has the correct appearance while maintaining the appropriate text. 
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Creating a template
Creating your template
There are lots of ways to create your template. You could

• Design and write your own
• Pay someone to do this for you  
• Modify a generic/Open Source template that you have bought or

"recycled"
• Use the super-simple DIY template in the next chapter.

Here are some tips to help you set up your template for use with Blink Mailer.

If you don't understand the information in this chapter and you don't have
anyone to help you with your template, then skip to the next chapter for a
super simple template.

The Basics  
You should use inline styles, and unless you have configured Blink Mailer
especially with a plugin, you must use a single column template.

If you choose a responsive template, your campaign editor should not use
images with a width larger than a smartphone screen (max 320 by 480 pixels).

The footer in Blink Mailer is quite specialised and is described in a separate
chapter. If you plan to have a footer in your design, please read the footer
chapter before you start work. 

Logo: upload or remote link?
When you are designing or modifying your template, you need to decide if you
will include your logo in the campaigns as an attachment or use a remote
image. If you include your logo as an attachment it will always display to the
recipient.

  

If you use a remote link, however, the image will only display when the
subscriber gives permission (in most email and webmail clients).
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If you decide to upload your image then leave the local link (or just a use a
"broken link") and you will be prompted to upload the image when you are
adding your template to Blink Mailer.

A mandatory placeholder in the body  
You must include some strings that Blink Mailer will replace during the sending
stage.

[CONTENT]  
The obligatory string is [CONTENT]. This will be replaced with the content of
your message when you send your campaign.

  

Adding your template to Blink Mailer
To add a template to Blink Mailer, go to Campaigns > Manage campaign
templates from the main menu.
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You will then see a list of templates already in the system. By default there is
one template, the system template (which styles things like the confirm
subscription emails).

Click Add new template.  

Name your template
First, give your template a Title. This will display in the list of templates to
choose from during the campaign composition stage, so it is important that the
name makes sense to the person writing the campaigns.

In this case we called the template Blink Mailer announcements, because it is
the template we use when we announce a new version of Blink Mailer. We
have different templates for community news and Blink Mailer hosted special
offers, for example.

Upload your file 

To add your template you can paste the html into the editor, or upload it as a
file. In this example we are uploading it.

Click the Browse button, locate the template file on your computer and
click Open. The file name will then appear next to the Browse button (as
shown in the image above).
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Save your template 

Scroll to the bottom of the page and click Save changes, using the checking
tools if you wish.

Upload your logo? 

The next screen gives you an opportunity to upload your template images, if
you have any. This will usually be a logo. In this case the logo is hosted
remotely and so no image is listed to upload.

Click Save images.

Your template will now be added to your list of Existing templates.

If you wish to set this template as the default for all campaigns, you can check
the button under CAMPAIGN DEFAULT.  

  

Defaults and settings 
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There are some default settings for templates and footers at Config > Settings
under campaign settings. 

For example you can choose which template will be used by default by
referring to its ID.

 

The ID of the template can be found next to the template name when you go
to Campaigns > Manage campaign templates from the main menu.

 

Using your template
During campaign composition, use headings and other formatting as normal.
You do not need to apply any additional styling such as text colour, if those
elements are dealt with in your template.
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In the Format of the send campaign workflow, select your template from
the Use template dropdown.  

   

The template and theme are then applied during sending.
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Advanced templating
More template placeholders
This chapter contains additional details that may be useful for a designer who
is creating a template for use in Blink Mailer. 

[SUBJECT] 
[SUBJECT] adds the subject of the email within the newsletter text.

[CONTENT] - a mandatory placeholder
This is where the message's content (body) will be inserted. Every template
must have a [CONTENT] placeholder. 

[FOOTER]
The message footer 

[SIGNATURE]
[SIGNATURE] prints the Blink Mailer image signature.

[FORWARDURL]
[FORWARDURL] is replaced with the personalised URL only. To use this, you
will need to wrap it in HTML, like this:

<a href="[FORWARDURL]">Forward to a Friend</a> 

[PREFERENCESURL]
[PREFERENCESURL] allows the recipient to edit their subscribe preferences, for
example update their email or the number of lists they belong to. This
essentially allows them to maintain your list up to date for you and is an
invaluable feature. 

[UNSUBSCRIBEURL] - a mandatory placeholder
[UNSUBSCRIBEURL] allows the recipient to totally unsubscribe from all your
lists. In Blink Mailer you must include this placeholder somewhere in your body
or footer. It is best to use this along side [PREFERENCESURL] if you manage
multiple lists, so subscribers can leave just one list rather than all lists if they
want. 
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[DOMAIN]
Prints your domain, e.g. yourdomain.com as listed in your configuration
settings.

[EMAIL]
Prints the subscribers email address.

Some older placeholders
These are some older placeholders which still work, but are not recommended
for use: 

[FORWARD]
[FORWARD] is a link where the recipient can go to “forward this message”. The
default text for this placeholder is this link.

For example, if you use "If you want to forward this message to a friend click
[FORWARD]", it will come out as: 

[UNSUBSCRIBE]

Like Forward the link that subscribers can use to unsubscribe. It will also be
replaced with "This Link", which means you can use it like this:

To unsubscribe from our newsletter click [UNSUBSCRIBE]

[PREFERENCES]

Like Forward and Unsubscribe the link that subscribers can use to update their
personal details and preferences. It will also be replaced with "This Link",
which means you can use it like this:

To change your preferences click [PREFERENCES]

DIY: Super simple template
We have made a very basic template for you to use. You will also need

•A version of your logo or similar image measuring 300px wide. 

Download and save the template
Download the template by clicking here and then saving the file to your PC. 
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Upload the template to Blink Mailer
Go to Campaigns > Manage campaign templates.

Click add new template. 

 

Give your template a name, for example My Newsletter Template. Then
click Browse. 

Select the file you downloaded earlier, called basic-template.html, from your
computer and click Open. 
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Then click Save Changes.

 

Upload your logo to Blink Mailer
You will then be directed to add your logo. Remember, it must be no more
than 300 pixels wide. Click Browse. 
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Select your logo file from your computer and click Open. 

Click Save Images. 

Make the template your default?
You will see your new template added to your list of existing templates. If you
will use this template for most of your campaigns, click the radio button
under Campaign Default. 

Copy this footer text
<a href="[PREFERENCESURL]" title="Update your preferences">Update your
preferences</a> | <a href="[UNSUBSCRIBEURL]" title="Unsubscribe"
>Unsubscribe</a>
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Add the footer to Blink Mailer
First go to Config > Settings.

Then scroll down till you find the Campaign Settings area. 

Click the edit icon
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Delete the contents up to the -- and right-click to Paste in the html you copied
from this chapter.

Click Save Changes. 

Any new campaigns will now use this footer by default. 

Using your new template
Compose a new campaign. In this example I have pasted the html from my
latest blog. 
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Check that you are using your template by clicking Next and examining
the Format tab. 

 

Send a test message using the Send test box at the bottom of the page.
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Take a look at the email when it arrives. You will notice your logo displays
even when other, remote images are blocked, because Blink Mailer has sent it
as an attachment. 

 

And you can see your template has been applied,
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Subscribe page design and 
configuration
Subscribe page is the name of the page where your subscribers can join your
lists. You can have as many subscribe pages as you want, and you can make
them look like your website. 

You can customise your subscribe pages in various ways. You can edit the default
design, which will affect all the pages, on your Config > Settings page, and/or
you can tweak the design of individual pages using the Header and Footer boxes
on the subscribe page editor.  

Modifications from within the Config > Settings page 
Go to Config > Settings from the main menu, and scroll down to the
subscription-ui settings area. Here you can edit the html of the pages, and also a
few basic settings.

Modifications from within the subscribe page editor 
The Header and Footer boxes in the General Information section of Config >
Subscribe Pages > add/edit a page can be used to edit the HTML of an individual
subscribe page.

The html in these boxes is generated from the defaults in Config > Settings >
subscription-ui settings, which can also be edited (see above).

You don't need to use <HTML> <head> etc, as Blink Mailer already includes this
for you. However, you can add your own Meta Tags and CSS file links or your own
<scripts> just so long as all these extras are above the </head>.

If you create your own CSS styles for your page, save the file outside of the Blink
Mailer folder structure, for example in the stylesheets directory. Then add a rel
link to the new file above the </head> tag. Keeping it outside of the Blink Mailer
folder structure will make it easier to upgrade later on. 

<link rel="stylesheet" href="/styles/customised.css" type="text/css" />

Advanced Customisation
You may wish to heavily customise your Subscribe page, to make it look like it is
part of your website (rather than third party software).

You should use a HTML editor for this task. You create a blank page in your HTML
editor, then copy and paste the contents of the Header box and replace the code
</head> <body> in the HTML editor with the copied code.

You will need to be careful with exactly how much you paste into the Header box
and whatever you do paste must fit within the <TABLE> below the <!-- Top table
starts →
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Advanced campaign 
statistics
This chapter covers

• The statistics menu
• Drilldown by campaign into clicks and/or opens
• Domain statistics 
• Using a Google tracking code
• Forward to a friend.

Basic statistics, as found in the Statistics Overview, are covered in the chapter
called Basic Campaign Statistics. 

The Statistics Menu
The statistics menu pulls together a lot of features. It is worth exploring what
can be found though this menu. The main items on the menu are Overview,
Opens, Campaign clicks, URL clicks and Domain statistics. You may also see
other options, for example Advanced statistics, if your statistics plugins is
activated.

To get a basic understanding of what data is available you can work
methodically from the top down, first viewing each page, then seeing what
links are provided in each page, and onwards. You will often come full circle.

 

In this chapter we will approach our drilldown from analysing one campaign,
covering both opens and clicks. You can also compare multiple campaigns, or
focus on a specific URL you are trying to drive traffic to. The approach you take
depends on the questions you are trying to answer.

Drilling down into an individual campaign
The starting point for an analysis of a single campaign is the campaign
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statistics overview. This can be found in Campaigns > List of campaigns >
Sent Campaigns by clicking on the graph button.

and also by visiting Statistics > Statistics overview and clicking on the name of
the campaign.

 

Either of these routes will bring you to the Statistics Overview for a campaign.
The page gives you an overview of information and two ways to drilldown are
available.
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Opened Drilldown
By clicking the number of opens, you can get a a page called Open Statistics.

 

This page allows you to Download as a CSV file a list of those subscribers who
were registered as having opened the campaign (remember this is by no
means everyone, only those recorded).

The csv file can in turn be used to create lists of active subscribers, or by using
the list-exclude feature you can isolate inactive subscribers too.

 

You can also click on an individual subscriber to drilldown to the subscriber
level.
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This will take you to the Campaigns tab in the History section of the Subscriber
profile, where you can click further links to view the campaigns they have
opened (left) or the links they clicked on in that campaign (right).

You can also see the date on which they viewed a campaign and the response
time (in seconds).
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Clicked Drilldown 
In your campaign statistics overview page, you can also choose to drilldown
into clicks data.

 

This will take you to a list of the links in that campaign, and how many people
clicked on each one.
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If you click on the url you can see how many people clicked on that url across
all campaigns which contained it.  
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That data can also be downloaded as a csv. 

 

Domain Statisics
The Domain statistics page is accessible from the main statistics menu and it is
a fascinating page which can give you real insight into the nature of your
subscribers. 

Using a google tracking code
Using a Google tracking code ensures that any visits to your website from the
campaign are recorded in Google Analytics, if you have Google Analytics
tracking installed on your site.

Google tracking is quite different to the in-built Blink Mailer opens/views
tracking. Firstly the data is not collected, stored or viewed in Blink Mailer. Also,
if you link to another website in your campaign and if that website also has
Google Analytics tracking on their site (which is likely) then they also receive
data. In that sense the tracking code is not exclusive to you.

To turn on Google tracking for an individual campaign, click the add Google
Analytics tracking code in the Finish tab of the campaign workflow.
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To turn on the use of tracking codes for every campaign, use the Always add
Google tracking code to campaigns in your campaign settings area, which can
be accessed from Config > Settings.
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To view the data in your Google Analytics go to Acquisition > Campaigns and
you will see the name of each campaign.

 

Forward to friend
On your Statistics > Statistics overview page, the third column, FWDS, shows
the number of people who have forwarded the mail through the Blink
Mailer ForwardToFriend system.

This system uses a placeholder to create a link or form in the email body or
footer of your campaign for your subscribers to use to forward the mail to
someone else.  

If your subscribers use this method to forward your campaign, any actions
(clicks, forwards etc) taken by the new recipient will be included in your
campaign statistics separately.

It is possible for you subscribers to forward the message by other means, but
you cannot reliably tell: any clicks or opens in an email which has been
forwarded without the Forward to a Friend system will be recorded as actions
of the original subscriber.

It is therefore worth including an option to forward the campaign, using
the [FORWARDURL] placeholder, in the header or footer. For example,
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The subscriber will then see a forwarding link in the email footer:

When a subscriber clicks this link they are prompted to enter an email:
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Scheduling
In the campaign workflow you will find the scheduling tab.

If you want to send a campaign straight away, and there is no need to stop
sending before a specific time, then you can leave these details unchanged and
your campaign will simply send.

If your needs are more complex, read on.

Scheduling tab
Below is an image of the scheduling tab. We we will work though it from top to
bottom:
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Embargoed until
The campaign will not be sent until this time has passed. If you have a
campaign which you wish to send at a later date, perhaps when you out of the
office or away from your desk, then this is the feature you should use.

Embargo time is initially set to the nearest hour before you started your new
campaign: this effectively switches off the embargo feature by default. To use
the feature you must set the time in the future. Simply set the date and time
to the time you want to send, relative to your server time which is stated
above. Then place the campaign in the queue as normal. If you are using a
cron job then the campaign will automatically start sending at the desired
time.
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Stop Sending After
This feature is used when the topic of a campaign is time sensitive, for
example, a special offer with an expiration date or an event with a specific
time. If the campaign would become irrelevant to anyone who received it after
a particular time, then this is the feature you should use. 

The primary use of this feature is when your list size exceeds your sending
capacity within the timeframe you need to send your campaign in. For
example, if you have a list of 10,000 subscribers and can send 1000 emails in
an hour but the campaign becomes irrelevant in 8 hours time, you need to
stop sending before everyone on your list has received a copy of the mail.  

Re-Queue
The re-queue setting is used to send a campaign to subscribers who join a
list after the campaign is sent. Remember, a campaign will never be sent to
the same subscriber twice.
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As an example, you create a monthly newsletter on the first of January, and
send it to a list. Over the month you expect another 50 people to sign up, or
be added to your list manually, and you would also like them to automatically
receive a copy of the campaign. You would set up your campaign to re-queue
every day and to re-queue until 31st of January.

Sending a web page
To send a web page rather than a message to your subscribers, log in to your
Blink Mailer admin pages, then choose to Send a Campaign Admin >
Campaigns > Send a Campaign

From this page, click on Send a New Campaign (or edit an existing Campaign).
In this example, I'll use Send a New Campaign.
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This results in:

Choose Send a Webpage rather than Compose message and you should see
this:

 

 

In the send a web page - URL box, enter the path of the webpage you wish to
send. Click outside the box and the URL is validated.

If you get this message, then check and double check that the page you have
entered actually exists. The URL does look correct, but the page does not in
fact exist.
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Once the page to be sent has been validated, simply select the template for
your message (optional), the list to which you wish to send to (required),
check that the embargo time is correct and send the campaign out.

Display Issues 
Be aware that most email readers, especially those web-based ones
(Hotmail/Outlook, Gmail etc) will not show images by default, it will be up to
your subscribers to decide if they wish to receive images in emails by (usually)
clicking on a link in the email reader. Don't assume that your images will
automatically appear, so make sure your webpage includes ALT Text for each
image in your page when designed.

Sending plain text
Blink Mailer always generates a plain text version of your campaign, which is
then included in the html campaigns as a matter of course. This is part of the
normal working of email functionality. Blink Mailer also gives you two
additional features:

• Your subscribers can choose to receive plain text emails only 
• You can edit the plain text version to improve it.

You can see the plain text version embedded in the source of your email by
clicking View Source in your email client (exact instructions vary wildly)
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As you can see there is a plain text version in and amongst the html and other
code.

 

Why edit the plain text version?
The automatically generated plain text version may not be very attractive. It is
good practice to provide a quality plain text version because it:

•displays better in some email software
•makes your emails more accessible for people with visual impairments.

To assess the state of your default plain text version, you can click to view
your emails only in plain text. In a desktop email client this is
usually View > Message Body As > Plain text.
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You can then see your email as it would be displayed to someone who is only
able to receive plain text messages.

 

To improve this email and send a version formatted especially for these
subscribers only takes a few extra moments and, as you can see, provides a
much better quality of message.

 

Enabling plain text editing
Some installations do not show the Text tab, which is used to manually
configure your text-only email content. If your tabs look like this, you'll need to
change the configuration:
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To activate the Text tab in your installation, add the following lines to your
config.php file:

# Manual text part, will give you an input box for the text version of the
message 
# instead of trying to create it by parsing the HTML version into plain text 
define('USE_MANUAL_TEXT_PART',1);

An extra tab will now display in your campaign workflow. 

 

Create your plain text version 
Once you've created your HTML version in the Content tab (tab 1) click
the Next button.

 

You should now be in the second tab, Text.

You can manually compose the plain text version, or you can generate it
automatically by using the generate from HTML button. Some special
characters in your html email may cause this automatic generation to fail. You
can paste your text into this tab if you need to.
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The empty Plain text version of message box will now contain a text only
version of your html message.

The content should be the same as the html version. However images in the
html version will automatically be removed and replaced by text descriptions
and urls are replaced by links. You can edit the message further if required, to
make it as attractive and legible as possible.

Once you are happy with your plain text version, click Save and continue
editing button, at the bottom of the text editing box, and carry on with testing
and sending your campaign.

 

When you send tests, you will receive two emails, one text and one html.

Format tab: ONLY send plain text?
On the format tab there is a radio button for sending in either HTML or Text.
Typically you will want to select the "HTML" radio button, which sends a
version of the message that each subscriber specified when they joined your
list.

However, if you want to send the text version of the message, select the
"Text" radio button. This will override the user preferences, and send all
subscribers the text version of the email.
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Bounce management
Introduction to bounce management
Whenever an email is sent via the internet, regardless of the email software
used, the email is transmitted by an MTA (Mail Transport Agent).  In most
cases the MTA is the internet provider’s SMTP mail server, sending to the MTA
of the email’s recipient, through intermediary MTAs.

If the email cannot be delivered to its recipient, the last MTA that tried to
transmit the email generates an error email, called a bounce message, which is
sent back to the sender’s email.

Usually, this bounce message contains a specific error code that explains why
your email could not be delivered to its recipient.

Blink Mailer implements bounce management which handles these bounce
messages, and provides automatic actions depending on the error code, like
removing an incorrect email address. 

Advanced bounce management
Advanced bounce management enables the automatic performance of various
actions depending on the kind of bounce error code that is returned by the
MTA.

To enable it just add the following in config.php

define('USE_ADVANCED_BOUNCEHANDLING',1);

Once this is set up, you may proceed in the Blink Mailer interface
to System > Manage Bounces > List Bounces Rules
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From there you may create new bounce rules, based on regular expressions
that will trigger Blink Mailer actions.

Regular expressions are sequences of characters that match a search pattern.
While this manual won’t explain the use of regular expressions, we will analyse
the examples given here.

Bounce emails generally contain a header and a mail body that may,
depending on the MTA that sent the email, give a reason why the initial email
could not reach its recipient.

An example bounce email could look like the following:

Final-Recipient: rfc822; someuser@example.com

Original-Recipient: rfc822;someuser@example.com

Action: failed

Status: 5.2.1

Remote-MTA: dns; mx1.example.com

Diagnostic-Code: smtp; 550 5.2.1 This mailbox has been blocked due to

inactivity (UserSearch)

What we see here is the recipient’s MTA telling us that the user’s mailbox is
blocked, probably because it’s not been used for a long while. There are some
excellent articles about MTA responses on the internet. Every MTA programme
has its own return messages. Also, you may have noticed that the return
messages usually come with a 3 digit code, 5.2.2 in this example.

This code is the error code corresponding to the return message, but some
MTAs just give bogus codes, especially when they think your email is spam.

Now let’s create our first bounce rule:
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The regular expression could be the exact sentence the MTA return message
contained, in brackets.

Now Blink Mailer provides multiple actions that can be triggered if a bounce
email matches our regular expression:

• Delete subscriber
• Unconfirm subscriber
• Blacklist subscriber
• Blacklist email address
• Delete subscriber and bounce
• Unconfirm subscriber and delete bounce
• Add subscriber to the do-not-send list and delete bounce
• Add email address to the do-not-send list and delete bounce
• Delete bounce.

In our case, we can assume that our subscriber’s email address haven’t been
used for a long while, and that it’s safe to unconfirm the subscriber.

Now we have a choice between “unconfirm subscriber” and “unconfirm
subscriber and delete bounce”. The only real difference between both options
is that deleting the bounce message will also remove it from bounce statistics
(using the BounceStatisticsPlugin).

Once we finished our rule, we may add it and try it against our bounces.
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Back in Blink Mailer, we can check if our rule matches any of our actual
bounces, by going to System > Manage Bounces > Check Current Bounce
Rules.

The system will then tell us how many bounces are caught by our rules.

Now you may have a big list of bounces that aren't caught by the rule, and
some of them are pretty similar to the rule.

We may have multiple bounce messages that could say “account is disabled”
or “This account has been disabled” which basically means the same as
“mailbox has been blocked due to inactivity” of our first rule.

Way may create two other rules to deal with these bounces, or improve our
regular expression to match all these messages with the same rule.

Regular expressions use the pipe symbol “|” as OR statement, meaning the
following regular expression:

(black|white) would match any text that has the words black or white in it.

Now let’s improve our first rule by adding all our MTA return messages that
basically mean the same thing:

The actual regular expression I used here is:

(account is disabled|This mailbox has been blocked due to inactivity|This
account has been disabled|The email account that you tried to reach does not
exist|This is a permanent error * local delivery failed)

Note that the * is a wildcard token that means there can be up to zero
characters between “This is a permanent error “ and “ local delivery failed”.

This rule can now deal with any of these 5 return messages.
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Good starter rule set:

Rules to copy
(Archived recipient.) Delete subscriber

(delivery error: dd This user doesn't have a yahoo.fr account|This user doesn't
have a yahoo.fr account) Delete subscriber

(type=MX: Host not found) Delete subscriber. No mail records for the domain.

(sorry, no mailbox here by that name|Mailbox disabled|address not found in
table|User mailbox is not local|mailbox not allowed|Mailbox syntax incorrect|
RESOLVER\.ADR\.RecipNotFound) Delete subscriber and bounce. No ambiguity
here, we can also delete the bounce message.

(account is disabled|This mailbox has been blocked due to inactivity|This
account has been disabled|The email account that you tried to reach does not
exist|This is a permanent error * local delivery failed) Delete subscriber and
bounce. Same as above

(User unknown|Unknown user|Unknown address|No such recipient|No such
user|The email account that you tried to reach is disabled|Recipient not found|
Recipient unknown|Invalid recipient|Address unknown|Recipient address
rejected) Delete subscriber and bounce. Same as above
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